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Signet 2551 Display Magmeter

English

The 2551 Magmeter measures the flow rate in a full pipe by monitoring the voltage 
produced when the (conductive) fluid moves through a magnetic field. Output 
options include a traditional frequency signal, a serial data (Digital (S3L)) output, 
and a 4 to 20 mA output.
The 2551 Magmeter is available in three sizes that will accommodate pipes from  
½ inch through 36 inch diameters.
Select from three different material combinations to match the Magmeter to the 
application requirements.
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1.	 Depressurize and vent system prior to installation or removal.
2.	 Confirm chemical compatibility before use.
3.	 Do not exceed maximum temperature / pressure 

specifications.
4.	 Wear safety goggles or faceshield during installation/service.
5.	 Do not alter product construction.

Failure to follow these instructions may result 
in the sensor being ejected from the pipe!
If leaking is observed from the retaining cap, it 
indicates defective or worn o-rings on the sensor. 
Do not attempt to correct by further tightening.

Caution / Warning / Danger
Indicates a potential hazard. Failure to follow all warnings 
may lead to equipment damage, injury, or death
Electrostatic Discharge (ESD) / Electrocution Danger
Alerts user to risk of potential damage to product by 
ESD, and/or risk of potential of injury or death via 
electrocution.
Personal Protective Equipment (PPE)
Always utilize the most appropriate PPE during 
installation and service of Signet products.

Pressurized System Warning
Sensor may be under pressure, take caution to vent 
system prior to installation or removal. Failure to do so 
may result in equipment damage and/or serious injury.

Hand tighten only!

Hand Tighten Only
Overtightening may permanently damage product 
threads and lead to failure of the retaining nut.

Do Not Use Tools
Use of tool(s) may damage product beyond repair and 
potentially void product warranty.

Note / Technical Notes
Highlights additional information or detailed procedure.

Refer to your local Georg Fischer Sales office for the most 
current warranty statement.
All warranty and non-warranty repairs being returned must 
include a fully completed Service Form and goods must be 
returned to your local GF Sales office or distributor.  
Product returned without a Service Form may not be  
warranty replaced or repaired.
Signet products with limited shelf-life (e.g. pH, ORP, chlorine 
electrodes, calibration solutions; e.g. pH buffers, turbidity 
standards or other solutions) are warranted out of box but not 
warranted against any damage, due to process or application 
failures (e.g. high temperature, chemical poisoning, dry-out) or 
mishandling (e.g. broken glass, damaged membrane, freezing 
and/or extreme temperatures).

Thank you for purchasing the Signet line of Georg Fischer 
measurement products.
If you would like to register your product(s), you can now 
register online in one of the following ways:
	 •	� Visit our website www.gfsignet.com.  

Under Service and Support click on  
Product Registration Form

	 •	 If this is a pdf manual (digital copy), click here

Chemical Compatibility

116.8 mm
(4.6 in.)

-X0
-X1
-X2

94 mm 
(3.7 in.) 

Blind Version 

79.25 mm 
(3.12 in.) 

-X0
-X1
-X2

Pipe Range:
   1/2 to 4 in. -X0 =  58 mm (2.3 in.)
   5 to 8 in. -X1 =  91 mm (3.6 in.)
   10 to 36 in. -X2 =  167 mm (6.6 in.)

X = Sensor Body P, T, or V

95.3 mm
(3.75 in.)

Display Version

Pipe Range
   1/2 to 4 in. -X0 =  58 mm (2.3 in.)
   5 to 8 in. -X1 =  91 mm (3.6 in.)
   10 to 36 in. -X2 =  167 mm (6.6 in.)

X = Sensor Body P, T, or V

Dimensions

Warranty Information

Product Registration

Safety Information

The retaining nuts of Magmeters are not designed for 
prolonged contact with aggressive substances. Strong acids, 
caustic substances and solvents or their vapor may lead to 
failure of the retaining nut, ejection of the sensor and loss of 
the process fluid with possibly serious consequences, such as 
damage to equipment and serious personal injury. Retaining 
nuts that may have been in contact with such substances e.g. 
due to leakage or spilling, must be replaced.

Pipe Range Insertion Depth
½ in. to 4 in. -X0 = 58 mm (2.3 in.)
5 in. to 8 in. -X1 = 91 mm (3.6 in.)
10 in. to 36 in. -X2 = 167 mm (6.6 in.)

X = Sensor Body Material (P, T, or V)

DO NOT USE thread sealant
or lubricants on the fitting threads!

Do not use any tools to
tighten the yellow retaining cap.
DO NOT USE thread sealant or
lubricants on retaining cap!

Lubricate O-rings with a 
non-petroleum based, viscous
lubricant (grease) compatible
with the system.

https://www.gfps.com/country_US/en_US/service_and_support/registration.html
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Power Requirements
4 to 20 mA......................�21.6 to 26.4 VDC, 22.1 mA max. 

400 mV p-p maximum ripple voltage
Frequency......................5 to 26.4 VDC, 15 mA max.
Digital.............................5 to 6.5 VDC, 15 mA max.
Auxiliary..........................�9 to 24 VDC, 0.4A max  

(only required for units with relays)
Reverse polarity and short circuit protected
Current output (4 to 20 mA)
Max Loop Resistance.....300 Ω
Loop Accuracy................32 µA max. error (25 °C @ 24 VDC)
Temp. drift.......................± 1 µA per °C max.
Power supply rejection....± 1 µA per V
Isolation: ........................�Low voltage < 48 VAC/DC from 

electrodes and aux power
Maximum cable..............300 m (1000 ft)
Error condition................22.1 mA
Frequency output
Output modes.................Freq, Freq÷10, or Mirror Relay 1
Max. Pullup Voltage........30 VDC
Max. Current Sink...........50 mA, current limited
Maximum cable..............300 m (1000 ft)
Reverse Polarity Protected to -40 V
Digital (S3L) Output
Serial ASCII, TTL level 9600 bps
Compatible with Signet 8900, 9900, 9950 and 0486 Profibus 
Concentrator
Maximum cable....... �Application dependent (See 8900 manual)
Relay Specifications
Relay 1 and 2 Type.........Mechanical SPDT
Rating.............................�5 A @ 30 VDC max.,  

5 A @ 250 VAC max.
Relay 3 Type...................Solid State
Rating.............................50 mA @ 30 VDC, 50 mA @ 42 VAC
Hysteresis.......................Adjustable, plus timer delay
Trigger Delay..................Adjustable (0 to 9999.9 sec.)
Relay Modes..................�Off, Low, High, Window, and  

Proportional Pulse
Relay Source..................Flow Rate, Resettable Totalizer
Error Condition...............Selectable; Fail Open or Fail Closed
Display
Characters......................2 x 16
Contrast..........................User-set in four levels
Backlighting....................�Requires external 9-24 VDC,  

0.4 mA max. (only on relay versions)

Environmental Requirements
Enclosure ......................NEMA 4X / IP65 (with cap installed)
Case...............................PBT
Display window...............Polyamide
Storage Temperature......-20 °C to 70 °C (-4 °F to 158 °F)
Relative Humidity...........0 to 95% (non-condensing)
Operating Temperature:
	 Ambient.......................-10 °C to 70 °C (14 °F to 158 °F)
	 Media..........................0 °C to 85 °C (32 °F to 185 °F)
Operating pressure:
	 Maximum....................�10.3 bar @ 25 °C (150 psi @ 77 °F) 

1.4 bar @ 85 °C (20 psi @ 185 °F)

Specifications
General
Pipe size range...............DN15 to DN900 (½ in. to 36 in.)
Flow Range....................Minimum:  0.05 m/s (0.15 ft/s)
(Bi-directional)................Maximum: 10 m/s (33 ft/s)
Linearity..........................�±1% of reading +0.01 m/s (0.033 ft/s)
Repeatability...................±0.5% of reading @ 25 °C (77 °F)
Minimum Conductivity....20 µS/cm
Wetted Materials
Sensor body and Electrodes and Grounding ring:
	 -P0, -P1, -P2...............Polypropylene and 316L SS
	 -T0, -T1, -T2................PVDF and Titanium
	 -V0, -V1,-V2................PVDF and Hastelloy-C
	 O-rings........................�FKM (standard) EPDM, FFKM 

(optional)

The user is responsible for determining 
the chemical suitability of these materials 
for a specific application.

Standards and Approvals
	 •	 CE
	 •	 UL/CUL (for display versions with relays)
	 •	 NSF (3-2551-P versions only)
	 •	 RoHS compliant
  	China RoHS (visit gfsignet.com for details)
	 •	� Manufactured under ISO 9001 for Quality, ISO 14001 

for Environmental Management and OHSAS 18001 for 
Occupational Health and Safety.

  	�Declaration of Conformity according to FCC Part 15  
This device complies with Part 15 of the FCC rules.  
Operation is subject to the following two conditions:  
(1) This device may not cause harmful interference, and, 
(2) This device must accept any interference received, 
including interference that may cause undesired operation.
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Installation

Pipe fittings
Georg Fischer offers a wide selection of installation fittings 
that control the position of the Magmeter electrodes in relation 
to the dimensions of the pipe. You will find a complete list of 
order numbers for installation fittings in the Calibration Tables 
on pages 8, 9.

Location of Fitting

To ensure the fluid velocity profile is 
Fully Developed, without distortion 
from piping system components, 
please adhere to the recommended 
straight run geometry.

Flow    

Reducer

15 x I.D. 5 x I.D. 20 x I.D. 5 x I.D.

90° Elbow

40 x I.D. 5 x I.D.

2 x 90° Elbow
3 dimensions

25 x I.D. 5 x I.D.

2 x 90° Elbow

50 x I.D. 5 x I.D.

Pump/Valve

+
G

F
+

+GF+

+GF+

OK

OK

OK

Vertical flow is ok
if the pipe remains
full at all times. 

Fl
ow

   
 

Flow    

Flow    

Flow    

Flow    Flow    

Flow    

Sensor Mounting Position
Horizontal pipe Runs
To minimize adverse effects of air pockets, sediment, or 
excessive rotor wear (Paddlewheels), avoid mounting the flow 
sensor at the top of the pipe (0º), bottom of pipe (180º), or the 
sides (90º) from vertical.

Vertical Pipe Runs
Mount flow sensorsin any direction. To ensure pipe is flowing 
full, with some back pressure, it’s highly recommended the 
fluid flow is upward.

Gravity and Discharge Lines
It’s recommended to install a trap to ensure pipe is full during 
flow conditions, and to minimize air pockets.

180°

90°90°

0°

Flow    

Reducer

15 x I.D. 5 x I.D. 20 x I.D. 5 x I.D.

90° Elbow

40 x I.D. 5 x I.D.

2 x 90° Elbow
3 dimensions

25 x I.D. 5 x I.D.

2 x 90° Elbow

50 x I.D. 5 x I.D.

Pump/Valve

+
G

F
+

+GF+

+GF+

OK

OK

OK

Vertical flow is ok
if the pipe remains
full at all times. 

Fl
ow

   
 

Flow    

Flow    

Flow    

Flow    Flow    

Flow    

Type Description
Plastic tees •  0.5 in. to 2 in. versions

•  MPVC or CPVC

PVC Glue-on 
Saddles

•  10 in. and 12 in. only
•  Cut 2½ in. hole in pipe
•  �Weld in place using 

solvent cement
PVC Clamp-on 
Saddles

•  �2 in. to 4 in., cut 1-7/16 
inch hole in pipe

•  �6 in. to 8 in., cut 2-1/8 in. 
hole in pipe

Iron Strap-on 
saddles

•  �2 in. to 4 in., cut 1-7/16 
inch hole in pipe

•  �Over 4 inch, cut 2-1/8 inch 
hole in pipe

•  �Special order 14 in. to  
36 in.

Iron, Carbon Steel & 
316 Stainless Steel 
Threaded Tees

•  0.5 in. to 2 in. versions
•  �Mounts on Threaded  

pipe ends
Carbon steel & Stainless 
Steel Weld-on Weldolets

•  �2 in. to 4 in., cut 1-7/16 
inch hole in pipe

•  �Over 4 inch, cut 2-1/8 inch 
hole in pipe

Fiberglass Tees
•  1.5 in. to 2 in. PVDF insert

Union Fittings 
and Wafers

•  �For pipes from  
DN 15 mm to 50 mm 
PP or PVDF

FPT

FPT

FPT

FPT

FPT

FPTFPT

FPT

Selecting a Location
•	 �The 2551 requires a full pipe and a fully developed turbulent flow profile 

for accurate measurement.
•	 �In vertical installations, assemble the 2551 so the conduit ports are 

facing downward. This prevents condensation inside the conduit from 
being directed into the 2551 electronics housing.

•	 �Chemical injection systems can temporarily alter the fluid conductivity 
and cause anomalies in the magmeter measurement.

•	 �To avoid this problem, install the magmeter UPSTREAM of the  
injection point.

ENTER

9900

2551

9900
2551

ENTER

Flow    

Flow    

Injection Point

Injection Point
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2551 Display Magmeters use a dual-sided electronics 
module and dual conduit ports. Unused ports must be 
sealed to protect the electronics from water damage.
1.	The lower set of conduit ports provide access to the 

wiring terminals for:
	 • Loop Power
	 • �Flow Output Signal (current loop, Digital (S3L), 

frequency or Mirror Relay 1 output).
2.	The upper set of conduit ports provide access to the 

wiring terminals for:
	 • Relay output wiring
	 • Auxiliary power for relay coils and display backlight
3.	The sensor is marked with a directional arrow to indicate 

the direction identified as forward flow.
	 • �An adhesive decal is also provided that can be affixed 

to the pipe to indicate the direction of forward flow.
	 • �Flow in the opposite direction from the arrow will be 

identified as reverse flow on the display by a "-" symbol.
4.	The terminals in the magmeter are designed to 

accomodate 16 to 22 AWG conductors.
5.	� The display includes two LEDs that light when  

Relay 1 or Relay 2 are activated.
	 • �All three relays can be monitored by scrolling to the 

Relay Status display located in the View menu.
	 • �If the Language option has not been made, new 

magmeters will always open with the Select Language 
display.

Language 
              English             > 

Security Code 
                  ****                  > 

Contrast 
                     2                  > 

Total Reset 
               Lock On            > 

Noise Rejection 
                60 Hz               > 

Flow Decimal 
                 ****.**              > 

Total Decimal 
               ******.**              > 

Separator 
                 ddd.d             > 

Output Mode 
           Frequency         > 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

Enter  Menu
                    Options                >

6.	The part number, serial number and output type are 
identified on the electronics module.

Signet Magmeter

RELAY 1 RELAY 2

ENTER

         420  GPM
                      123456.78           >

3.
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s/n 60504201234
60504201234
p/n 3-2551-11
3-2551-11

6.
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2.

Overview of Magmeter Display

2551 Magmeter
R
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4-20 mA Loop Output

1

2

3

4

Auxiliary Power for:
Display backlighting
Relay Coils

2551 Magmeter

4.
5-
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V
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C

R
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R
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V-
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- VDC
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3

Frequency Out
Frequency ÷ 10 Out
(5 to 26.4 VDC)
**********************
Digital (S  L) Out
(4.5 to 6.5 VDC)

1

2

3

4

Auxiliary Power for:
Display backlighting
Relay Coils

4 20

Ground

Signal

3-2551-21 and 3-2551-41 Magmeters may be programmed 
in the OPTIONS menu to provide an open collector 
FREQUENCY output.
•	 The maximum frequency output is 1000 Hz  

(at 10 meters per second)
•	 If the Frequency ÷ 10 output is selected, the maximum 

frequency is 100 Hz (at 10 meters per second).
•	 AUX PWR must be connected to power the display 

backlighting and to power the relay coils if included.

Wiring to Frequency Output

1

2

3

4

5-24 VDC

Ground
Not used

Open Collector Out

2551 Magmeter

The 3-2551-21 and 3-2551-41 Magmeter can be configured 
in the OPTIONS menu to provide an Open Collector output 
in lieu of the sensor signal provided by Frequency or Digital 
(S3L) output selections. The Open Collector output can be 
programmed via the Relay 1 menu.

Wiring to Mirror Relay 1 Output
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2551 Frequency Out to 
8900 Controller

1

2

3

4

10
K
Ω

1

2

3

4

9

8

7
3

4

3-8900.621CI/O Module 3-8900.401-X
1

2

3

4

5

6

7

8

9

10

11

+5VDC (Black)
Freq. Input (Red)

GND (Shield)
+5VDC (Black)

Freq. Input 2 (Red)
S  L (Red)

GND (White/Shield)
+5VDC (Black)

S  L (Red)
GND (White/Shield)

3

3

Frequency
Input

1

Frequency
Input 2

OR
S3L

Input
2

S3L
Input

1

1

2

3

4

5-24 VDC

Ground

Not used

Frequency Out

2551 Magmeter

Install a pull-up resistor when connecting the
2551 Magmeter to other manufacturer's flowmeters.

5-24 VDC

Ground
Not used

Sensr Gnd
(SHIELD)

Sensr IN
(RED)
Sensr V+
(BLACK)

2551 Magmeter 8550-1 Flow Transmitter

Frequency

Ground

+5 VDC

Not used

Data

2551 Magmeter

Frequency

2551 Digital (S3L) Out to 
8900 Controller

1

2

3

4

10
K
Ω

1

2

3

4

9

8

7
3

4

3-8900.621CI/O Module 3-8900.401-X
1

2

3

4

5

6

7

8

9

10

11

+5VDC (Black)
Freq. Input (Red)

GND (Shield)
+5VDC (Black)

Freq. Input 2 (Red)
S  L (Red)

GND (White/Shield)
+5VDC (Black)

S  L (Red)
GND (White/Shield)

3

3

Frequency
Input

1

Frequency
Input 2

OR
S3L

Input
2

S3L
Input

1

1

2

3

4

5-24 VDC

Ground

Not used

Frequency Out

2551 Magmeter

Install a pull-up resistor when connecting the
2551 Magmeter to other manufacturer's flowmeters.

5-24 VDC

Ground
Not used

Sensr Gnd
(SHIELD)

Sensr IN
(RED)
Sensr V+
(BLACK)

2551 Magmeter 8550-1 Flow Transmitter

Frequency

Ground

+5 VDC

Not used

Data

2551 Magmeter

Frequency

Wiring to Signet Instruments
The 3-2551-22 and 3-2551-42 Magmeters provide a passive  
4 to 20 mA loop output.
•	 External loop power (24 VDC) is required.
•	 Factory standard calibration is 4 to 20 mA = 0 to 5 m/s.
•	 The 4 to 20 mA output can be spanned to any range,  

from -10 m/s to +10 m/s.
•	 AUX PWR must be connected to power the display 

backlighting and to power to the relay coils if included.

2551 Magmeter
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2551 Magmeter
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3

Frequency Out
Frequency ÷ 10 Out
(5 to 26.4 VDC)
**********************
Digital (S  L) Out
(4.5 to 6.5 VDC)

1

2

3

4

Auxiliary Power for:
Display backlighting
Relay Coils

4 20

Ground

Signal

Wiring to 4 to 20 mA Output

When using the 2551 in a system with other manufacturer's 
equipment, a 10 KΩ pull-up resistor (not supplied) may be 
required to power the open collector output.

1 

2 

3 

4 

Frequency Out 

2551 Magmeter 

24
 V

D
C

 

NO3 
NC3 

C3 R
el

ay
 3

 

V+ 
V- 

5-24 VDC 

Ground 

Ground 

A
ux

 P
w

r 

Sensr Gnd
(SHIELD)

Sensr IN
(RED)

Non-Signet
Flow Instrument

Ground 

Frequency Input 

5-24 VDC Out 

Auxiliary Power for:
Display backlighting
Relay Coils

10 KΩ
Pull-up Resistor

Wiring to other manufacturer's Instruments

The 3-2551-21 and 3-2551-41 Magmeter can be configured 
in the OPTIONS menu to provide a Frequency or 
Digital (S3L) output. 
Frequency and Digital (S3L) output can be used by Signet 8900 
Multi-Parameter Controller, 9900 Transmitter, 9950 Dual Channel 
Transmitter and 0486 Profibus Concentrator.

Wiring to Signet Instruments

2551 Frequency or Digital (S3L) 
Out to 9900 Transmitter

1

2

3

4

D
ATA

G
N

DV
+

S
H

LD

2551 Magmeter

9900 Transmitter

+5 VDC

Ground
Not used

Frequency or (S3L)

2551 Digital (S3L) Out to 
9950 Dual Channel Transmitter

2551 Digital (S3L) Out to 
0486 Profibus Concentrator

1

2

3

4

Loop

+V

FREQ

+V

FREQ

DATA

GND

Loop

C
H

2
C

H
1

+V

FREQ

DATA

GND

DC POWER

Black

White

9950 S3L Inputs

XNo connection

Shield

1

2

3

4

2551 Magmeter

GND

DATA

Freq IN

+5V OUT

White

Red
Black

0486 Profibus 
Channel 1 - 4

Red

2551 Magmeter

+5 VDC

Ground

Not used

Frequency or (S3L)

1

2

3

4

Loop

+V

FREQ

+V

FREQ

DATA

GND

Loop

C
H

2
C

H
1

+V

FREQ

DATA

GND

DC POWER

Black

White

9950 S3L Inputs

XNo connection

Shield

1

2

3

4

2551 Magmeter

GND

DATA

Freq IN

+5V OUT

White

Red
Black

0486 Profibus 
Channel 1 - 4

Red

2551 Magmeter

+5 VDC

Ground

Not used

Frequency or (S3L)
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Relay 3 is a solid state relay. It can be applied exactly the same as a 
dry contact relay, but the current rating is 0.2 A (200 mA) maximum. 
Relay 3 is best suited to pulse applications and low voltage loads.

Relays 1 and 2 are dry contact relays rated for 5 A maximum current.
They are best suited for switching high voltage loads, such as AC 
powered pumps and valves.
When used to switch inductive loads, the dry contact relays may be 
damaged by arcing. Signet recommends the installation of a filter 
device to prevent such damage.
3-8050.396	 159 000 617	 RC Filter kit (for relay use)

	 Relay 3 Type:	 Solid State
	 Rating:	 50 mA @ 30 VDC, 50 mA @ 42 VAC

Relay 1,	Relay 2 Type:	 Mechanical SPDT
	 Rating:	 5A @ 30 VDC max., 5 A @ 250 VAC max

Solid State Relay 3:
50 mA max @ 30 VDC
50 mA max @ 42 VAC

NO1

NO2

NO3

NC1

NC2

NC3

C1

C2

C3

V+

V-

Auxiliary Power
9 to 24 VDC
0.4 A Maximum

Mechanical Relays:
5A @ 250 VAC
5A @ 30 VDC

R
el

ay
 1

R
el

ay
 2

R
el

ay
 3

A
ux

 P
w

r

Auxiliary power must be connected to operate the relays and to 
power the display backlighting. Auxiliary power is fully isolated. 
The Loop Power supply may be used for Aux power if the 
power source provides a sufficient current rating.

Relay Terminal Legend:
NO:	Normally Open
NC:	Normally Closed
C:	 Common

Application Notes: Relay Wiring
•	 Inductive relay loads may generate transient voltage spikes well in excess of the relay contact ratings. This will cause arcing across 

the contacts and consequently rapid relay wear. Signet recommends an RC-style filter (“snubber”), installed as illustrated here.
•	 The filter kit (3-8050.396) is available as an accessory item. See ordering information on back cover.
•	 Signet product warranty does not cover damage to relays due to contact burnout.

3-8050.396

NO1

NO2

NO3

NC1

NC2

NC3

C1

C2

C3

V+

V-

120-240 VAC 

AC-powered:
Pumps
Alarm lamps
Audio alarms
Mixers

Definition:
An inductive load is an electrical device generally 
made of wire that is coiled to create a magnetic field 
to produce mechanical work when energized.
Examples of inductive loads include motors, 
solenoids, and relays.
High voltage transients from these types of loads can 
cause arcing across mechanical switching contacts 
or can cause damage to solid-state contacts.

Wiring Relays



8 Signet 2551 Display Magmeter

Security CodeKeypad Functions

Navigating the Menus

The 2551 has a security code that can be programmed to any 
four-digit numerical value.
•	 The factory setting is 0-0-0-0.
•	 To program the security code go to the Options menu.
•	 The security code will be required to edit any of the items in 

the menus. It is required only once for each editing session.
•	 Record the custom security code here or in a safe location.
•	 If the security code is lost, contact your Signet service 

center for instructions.

Normal Operation Display
The normal operating display shows the Flow Rate on the top line and the Resettable 
Totalizer on the bottom line.
•	 All menu instructions in this manual assume that the instrument is showing this display.

Calibration Menu
This menu provides two different methods for adjusting the calibration. See page 14 for details 
related to this menu.

Setup Menu
This menu contains all of the settings and information that the magmeter requires to operate, 
including the K-Factor, the totalizer settings, low flow cutoff, and several display characteristics. 
See page 10 for details related to this menu.

2551 Menu Directory
The 2551 Magmeter uses seven main menus to provide access to the calibration and 
programming features. Each menu serves a specific function.

Starting from the normal operating display, there are two ways to access the menus:
1.	 Press the ▲ key to scroll to the Enter Menu display, then press the ► key.
2.	 Press the ENTER key and hold it for about three seconds.

Enter Code
              0000              

3s 

ENTER 

Or 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

1234.56  GPM
       876543.21    >

Enter Menu
   >

Enter Menu
Setup    >

Enter Menu
Calibration    >

Enter Menu
Relay 1    >

Enter Menu
Relay 2    >

Enter Menu
Relay 3    >

Enter Menu
Test    >

Enter Menu
Options    >

ENTER
Scrolls UP through any menu.
If the display shows any flashing character or selection, 
scrolls UP to the previous value or selection.

ENTER Scrolls DOWN through any menu.
If the display shows any flashing character or selection, 
scrolls DOWN to the next value or selection.

ENTER

ENTER
Press the ▲ and ▼ keys together to abandon any 
unsaved edits and return to the previous display.

E
N

TE
R

Opens the menu currently being displayed.
In Edit modes, advances the flashing character.
In menus with only two options (Yes or No, On or Off) 
toggles between selections.

ENTER
Saves a new selection in any menu.
From Normal Operation display, jumps to first selection 
in Menu directory (when held for three seconds)

Security Code                                              

Relay Menus
Each of the available relays in the 3-2551-21 and 3-2551-22 are programmed from their own 
dedicated menu. See page 15 for details related to these menus. 
NOTE: �Menu items associated with Relays 2 and 3 are suppressed in models without relays. 

Test Menu
This menu is used to manually toggle relays or to induce a known value out of the 4 to 20 mA 
terminals. See page 17 for details related to this menu.

Options Menu
This menu contains those settings and values that are usually programmed during the initial 
installation, and then seldom modified, including the SECURITY CODE (see section below).  
See page 17 for details related to the Options menu.
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The VIEW menu contains all of the basic information available from the Magmeter.
•	 The normal operating display shows the FLOW RATE on the top line of the display 

and the Resettable Totalizer on the lower line of the display.
•	 The Right Prompt symbol (>) always indicates a sub-menu associated with the  

current display. In this display it points the way to the TOTALIZER RESET function. 
See below for detailed instructions.

•	 With AUXILIARY power connected to the magmeters with Relays, the display will be 
backlit. There is no switch to turn the backlight off.

•		�  A flashing character or text on the display indicates that the item is being edited.  
This manual uses a (red) star to illustrate a flashing display.

•	 The following information is viewed by scrolling ▲ or ▼. These displays will remain in 
the display for 10 minutes, then the normal operating display will return.

1.	 From the normal operating display, press the ► key.

3.	 Press any arrow key to toggle the flashing selection 
from NO to YES.

4.	 Press the ENTER key. The totalizer will reset to all 
zeroes and the display will immediately return to the 
normal operating display.

2.	 The resettable totalizer can be configured to require 
the security code before allowing the reset. If the 
Total Reset is set to "RESET OFF" this display will not 
appear. See page 17, Options Menu for instructions.

Show the permanent total. This totalizer cannot be reset.

This display is a reminder to visit the Signet website for updates 
and information about Signet products.

Enter menus from this display.  See page 10 for details.

Shows the current output.  For 4 to 20 mA Output models only.

123456.78  GPM
       000000.00    >

1234.56  GPM
       876543.21    >

Signet Magmeter

RELAY 1 RELAY 2

ENTER

1234.56  GPM
       876543.21    >

Enter Code
0000

Reset Total     ?
Yes       No

Gallons
Perm   876543.21

Current Output 
14.89  mA 

Relay       1        2        3
                   Off     Off    Off   

Web Site 
www.gfsignet.com 

Enter  Menu 
                                            > 

Signet Magmeter

RELAY 1 RELAY 2 

ENTER 

1234.56  GPM 
       876543.21    > 

Relay States shown for units with a relay board.

View Menu

Resetting the Resettable Totalizer

Gallons
Perm   876543.21

Current Output 
14.89  mA 

Relay       1        2        3
                   Off     Off    Off   

Web Site 
www.gfsignet.com 

Enter  Menu 
                                            > 

Signet Magmeter

RELAY 1 RELAY 2 

ENTER 

1234.56  GPM 
       876543.21    > 

Gallons
Perm   876543.21

Current Output 
14.89  mA 

Relay       1        2        3
                   Off     Off    Off   

Web Site 
www.gfsignet.com 

Enter  Menu 
                                            > 

Signet Magmeter

RELAY 1 RELAY 2 

ENTER 

1234.56  GPM 
       876543.21    > 
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Pipe Size 
               2”  DN50             > 

    K-Factor 
     060.000      > 

Flow Units 
                   GPM                > 

Averaging 
                25  secs             > 

Sensitivity 
                  100%               > 

Totalizer Units 
                Gallons               > 

Low Flow Cutoff 
                0.5  GPM       > 

Set 20 mA 
            100.00 GPM         > 

Set 4 mA 
                 -100 GPM            > 

Total Factor 
                  1000.0               > 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

   Enter Menu
                  Setup               >

K-Factor: See the charts on pages 12-13 for values in pulses per U.S. gallon or in pulses per liter. 
To use other units, convert the published values as appropriate.

Pipe Size:  Select the pipe size that is nearest to the nominal pipe size.

Averaging: Set the averaging period based on the installation and flow conditions. Smaller values 
allow the 2551 to respond to changes in flow rate quickly, while larger values smooth the fluctuations 
caused by installation and flow conditions. See page 11 for details.

Flow Units: Set the units for the application. Four characters are available. The first three characters can be set to any symbol or alpha 
character, upper or lower case. The following special symbols are located between the upper case and lower case menus:
  • (centered dot)	 µ (micro)	 _ (blank)
  - (dash)	 / (slash)	 3 (for cubic units)
The last character selects the timebase for the flow rate measurement.
Select S/s (seconds) M/m (minutes), H/h (hours) or D/d (days)

Total Factor: Set the factor by which the totalizer will count. This setting is made in the application 
units (i.e., gallons, liters, etc.)

Totalizer Units: Set the Totalizer Units. This setting serves as a label for the totalizer displays only. 
It has no effect on the measurement. The special characters listed in the Total Factor settings are 
available here also.

Low Flow Cutoff: Set a flow rate that the 2551 Magmeter will use as a minimum threshhold. 
If the flow rate falls below this value, the 2551 will respond as if the flow were zero.

Sensitivity: Set a percentage of maximum range by which the flow must change to override the 
averaging feature and "jump" quickly to the new flow rate. See detailed explanation on page 11.

The Setup menu contains all of the parameters necessary for the 2551 Magmeter to begin 
measuring flow.

NOTE: �The Security Code must be entered before any changes can be made to the Setup menu.
See page 17 for details related to the Options menu..

The values shown for each menu item represent 
the factory standard setting. All 2551 magmeters 
are packaged with these settings.

Set 4 mA: (2551-22 and -42 versions only) Set the flow rate where the current output will be 4 mA.

Set 20 mA: (2551-22 and -42 versions only) Set the flow rate where the current output will be 20 mA.

The 4 to 20 mA output may be spanned to monitor forward and reverse flow rates.

ENTER

Pipe Size 
               2”  DN50             > 

    K-Factor 
     060.000      > 

Flow Units 
                   GPM                > 

Averaging 
                25  secs             > 

Sensitivity 
                  100%               > 

Totalizer Units 
                Gallons               > 

Low Flow Cutoff 
                0.5  GPM       > 

Set 20 mA 
            100.00 GPM         > 

Set 4 mA 
                 -100 GPM            > 

Total Factor 
                  1000.0               > 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

   Enter Menu
                  Setup               >
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   Enter Menu
                  Setup               >
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Signet Magmeter
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Use the keypad to navigate through each setting.

Enter Code
              0000              

Setup Menu
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Sensitivity
•	 The SENSITIVITY setting determines how the 2551 

responds to sudden surges in the flow rate. It "overrides" 
the Averaging function just long enough to allow an actual 
change in flow rate to be displayed, then resumes the 
averaging. The result is a smooth flow display and a quick 
response to large shifts in the flow rate.

	 The settings for Sensitivity represent a percentage of the 
magmeter's maximum range, or 10 meters per second (m/s).

	 Example: A sensitivity setting of 25% means that the flow 
rate must change instantly and by more than 2.5 ms before 
the function is enabled.

NOTE: The SENSITIVITY function is ineffective if the 
AVERAGING function is set to zero.

Averaging
•	 The AVERAGING setting dictates the time over which the 

magmeter will average the flow signal.
	 The LCD display is updated every second. With averaging 

at 14 seconds, the flow rate on the display is an average of 
the previous 14 seconds input.

	 Short averaging times provide the fastest display and output 
response to changes in the flow rate.

	 Higher averaging times help to smooth the display and 
current output where the flow in the pipe is erratic or 
unstable due to installation limitations.

No Averaging
With AVERAGING set to zero, the flow rate will be displayed 
immediately and with no filtering. This line represents the 
actual output of the flow sensor as it responds to unstable flow 
conditions in the pipe.

10 s 20 s 30 s 40 s 50 s 60 s 70 sTime

Ve
lo

ci
ty

Averaging Only
With AVERAGING set to 50 seconds and SENSITIVITY still 
set to zero the flow rate is stabilized, but a sharp change in 
flow rate is not represented on the display or at the output for 
50 seconds or longer.

10 s 20 s 30 s 40 s 50 s 60 s 70 s
Time

Ve
lo

ci
ty

Averaging and Sensitivity
With AVERAGING at 50 seconds and SENSITIVITY set to 
25%, the flow rate is stabilized, while the sudden shift in flow 
is reflected very quickly.

10 s 20 s 30 s 40 s 50 s 60 s 70 sTime

Ve
lo

ci
ty

Even the most carefully engineered flow systems may 
experience  erratic and unstable conditions. If the instability is 
communicated to the output functions, the results may create 
problems for control devices.

To alleviate these issues, the 2551 provides two adjustments 
that operate in tandem. The information here will help 
in determining the appropriate settings for any specific 
application.

Averaging and Sensitivity

The SENSITIVITY function changes the 
response characteristics of the magmeter.  
If used as part of a tuned closed loop control 
system, such a change may be undesirable.

CAUTION
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• The 2551 magmeter is designed to measure bi-directional flow.
• The forward flow direction is indicated by the directional arrow molded into the side of the 2551 sensor.
• �The conduit ports are assembled at the factory to point UPSTREAM. They may be reversed by  

disassembling the components of the magmeter and reassembling.

Flow Rate Display �The "+" sign is suppressed during forward flow.  
"-123.45 GPM" during reverse flow.

Totalizer Display �The totalizer will count during forward flow conditions only.  
During reverse flow the totalizer will not increment.

Relay Outputs May be set to detect reverse flow: "Low Setpoint at -25 GPM."

4 to 20 mA output �May be scaled to span any flow range:  
For example: "4 to 20 mA = -100 GPM to +100 GPM"

Frequency output, Frequency ÷ 10 output �Reverse flow is processed same as forward flow in the frequency output magmeters.
Digital (S3L) output Reverse flow results in 0 flow rate output.

PVC Tees and Clamp-on Saddles

Pipe Size
(In.)

Fitting
Type

K-Factor
Gallons

K-Factor
Liters

SCH 80 PVC-U TEES FOR SCH 80 PIPE
½ MPV8T005 2277.0 601.58
¾ MPV8T007 1407.6 371.90
1 MPV8T010 861.17 227.52

1¼ MPV8T012 464.91 122.83
1½ MPV8T015 331.43 87.56
2 MPV8T020 192.89 50.96

SCH 80 PVC TEES FOR SCH 80 PIPE
2½ PV8T025 131.46 34.73
3 PV8T030 82.52 21.80
4 PV8T040 44.78 11.83

SCH 80 CPVC TEES FOR SCH 80 PIPE
½ MCPV8T005 2277.0 601.58
¾ MCPV8T007 1407.6 371.90
1 MCPV8T010 861.17 227.52

1¼ MCPV8T012 464.91 122.83
1½ MCPV8T015 331.43 87.56
2 MCPV8T020 192.89 50.96

SCH 80 PVC CLAMP-ON SADDLES FOR SCH 80 PIPE
2 PV8S020 193.83 51.21

2½ PV8S025 138.01 36.46
3 PV8S030 83.89 22.16
4 PV8S040 40.88 10.80
6 PV8S060 22.53 5.95
8 PV8S080 12.52 3.31

10 PV8S100 7.94 2.10
12 PV8S120 5.71 1.51

SCH 80 PVC CLAMP-ON SADDLES FOR SCH 40 PIPE
2 PV8S020 180.01 47.56

2½ PV8S025 123.72 32.69
3 PV8S030 75.81 20.03
4 PV8S040 41.87 11.06
6 PV8S060 19.71 5.21
8 PV8S080 11.73 3.10

10 PV8S100 7.43 1.96
12 PV8S120 5.23 1.38

Polypropylene True Union Tees 
and Wafers
PVDF True Union Tees, 
PVC True Union Tees

Pipe Size
(Metric)

Fitting
Type

K-Factor
Gallons

K-Factor
Liters

POLYPROPYLENE FITTINGS (DIN/ISO, BS, ANSI)
DN15 PPMT005 2192.73 579.32
DN20 PPMT007 1327.81 350.81
DN25 PPMT010 737.16 194.76
DN32 PPMT012 453.46 119.81
DN40 PPMT015 275.03 72.66
DN50 PPMT020 164.17 43.35

PVDF FITTINGS (DIN/ISO, BS, ANSI)
DN15 SFMT005 1946.49 514.26
DN20 SFMT007 1158.05 305.96
DN25 SFMT010 749.09 197.91
DN32 SFMT012 439.51 116.12
DN40 SFMT015 248.93 65.77
DN50 SFMT020 146.85 38.80

PVC FITTINGS (DIN/ISO, BS, ANSI)
DN15 PVMT005 2067.76 546.30
DN20 PVMT007 1136.61 300.29
DN25 PVMT010 716.52 189.31
DN32 PVMT012 446.07 117.85
DN40 PVMT015 278.83 73.67
DN50 PVMT020 159.36 42.10

Bi-Directional Flow

Calibration Data: K-Factors

Flow    
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Carbon Steel Tees and Weld-o-Lets
Stainless Steel Tees and Weld-o-Lets
Galvanized Iron Tees

Pipe Size
(In.)

Fitting
Type

K-Factor
Gallons

K-Factor
Liters

CARBON STEEL TEES ON SCH 40 PIPE
½ CS4T005 1572.66 415.50
¾ CS4T007 1086.73 287.11
1 CS4T010 582.34 153.86

1¼ CS4T012 377.48 99.73
1½ CS4T015 267.79 70.75
2 CS4T020 167.85 44.35

STAINLESS STEEL TEES ON SCH 40 PIPE
½ CR4T005 1601.26 423.05
¾ CR4T007 937.78 247.76
1 CR4T010 606.18 160.15

1¼ CR4T012 279.68 73.89
1½ CR4T015 147.65 39.01
2 CR4T020 111.90 29.56

STAINLESS STEEL WELDOLETS ON SCH 40 PIPE
2½ CR4W025 106.31 28.09
3 CR4W030 72.27 19.09
4 CR4W040 36.84 9.73
5 CR4W050 29.28 7.73
6 CR4W060 20.29 5.36
8 CR4W080 11.73 3.10
10 CR4W100 7.45 1.97
12 CR4W120 5.24 1.39

CARBON STEEL WELDOLETS ON SCH 40 PIPE
2½ CS4W025 105.70 27.93
3 CS4W030 70.68 18.67
4 CS4W040 36.38 9.61
5 CS4W050 29.28 7.73
6 CS4W060 20.29 5.36
8 CS4W080 11.73 3.10
10 CS4W100 7.45 1.97
12 CS4W120 5.24 1.39

GALVANIZED IRON TEES ON SCH 40 PIPE
1 IR4T010 558.50 147.56

1¼ IR4T012 334.45 88.36
1½ IR4T015 248.97 65.78
2 IR4T020 146.00 38.57

Bronze and Copper Tees and Brazolets

Pipe Size
(In.)

Fitting
Type

K-Factor
Gallons

K-Factor
Liters

BRONZE TEES ON SCH 40 PIPE
1 BR4T010 582.34 153.86

1¼ BR4T012 330.54 87.33
1½ BR4T015 254.76 67.31
2 BR4T020 157.36 41.58

COPPER TEES FITTING ON COPPER PIPE SCH K
½ CUKT005 2459.19 649.72
¾ CUKT007 1108.02 292.74
1 CUKT010 649.87 171.70

1¼ CUKT012 422.03 111.50
1½ CUKT015 281.43 74.35
2 CUKT020 136.02 35.94

COPPER TEES FITTING ON COPPER PIPE SCH L
½ CUKT005 2406.30 635.75
¾ CUKT007 1174.77 310.37
1 CUKT010 672.28 177.62

1¼ CUKT012 402.84 106.43
1½ CUKT015 294.99 77.94
2 CUKT020 149.63 39.53

COPPER/BRONZE BRAZOLET ON SCH 40 PIPE
2½ BR4B025 117.31 30.99
3 BR4B030 78.62 20.77
4 BR4B040 45.13 11.92
5 BR4B050 32.79 8.66
6 BR4B060 22.73 6.01
8 BR4B080 13.14 3.47

10 BR4B100 8.34 2.20
12 BR4B120 5.87 1.55

Iron Saddles

Pipe Size 
(In.)

Fitting
Type

K-Factor
Gallons

K-Factor
Liters

SCH 80 IRON SADDLE ON SCH 80 PIPE
2 IR8S020 194.85 51.48

2½ IR8S025 142.28 37.59
3 IR8S030 87.53 23.13
4 IR8S040 40.62 10.73
5 IR8S050 29.28 7.74
6 IR8S060 22.30 5.89
8 IR8S080 12.52 3.31
10 IR8S100 7.94 2.10
12 IR8S120 5.65 1.49

SCH 80 IRON SADDLE ON SCH 40 PIPE
2 IR8S020 185.35 48.97

2½ IR8S025 127.47 33.68
3 IR8S030 76.62 20.24
4 IR8S040 40.23 10.63
5 IR8S050 27.32 7.22
6 IR8S060 19.71 5.21
8 IR8S080 11.61 3.07
10 IR8S100 7.36 1.94
12 IR8S120 5.18 1.37

Calibration Data: K-Factors
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The K-Factors published in this manual assume that the flow conditions in the pipe are ideal.
Many factors that affect the flow rate are beyond the control of the magmeter; variations in actual 
pipe dimensions, pipe smoothness, and other flow conditions will contribute to the total system error.
Performing a custom calibration with the magmeter in place will adjust the K-Factor and can serve 
to compensate for installation conditions that may be less than ideal.
Select one of the calibration methods in this menu to achieve the most accurate measurement 
possible in a specific application.

Use this method if the 2551 Magmeter must be calibrated to match a reference flow meter.  This is the method most commonly used 
by monitoring agencies, and for large pipes where volumetric calibration is impractical.  The accuracy of this calibration method is 
largely dependent on the accuracy of the reference meter and the proximity of the reference to the Signet 2551 Magmeter.

Use the volume method of calibration if the fluid passing the magmeter can be measured by a volumetric method (as in a vessel of 
known volume, or by weight). It requires the ability to pump a known volume of water past the magmeter, and then input the volume 
into the 2551 program. It is most useful for small pipes and lower flow rates.
When performed properly, volumetric calibration is the most accurate method. For best results a five minute test period is 
recommended, and the test period should be no less than two minutes.

At START, the 2551 begins counting the flow past the sensor.

At STOP, the 2551 stores the total flow accumulated since the START.

Enter the VOLUME that has been pumped past the sensor.

This error message appears if volume entered or the accumulated flow is zero. 
Repeat the test after checking the system.

Set New Flowrate 
45.6789 

Press  Enter 
To Start 

Enter Volume 
000000.   GPM 

K-Factor 
45.6789 

K-Factor 
56.7890 

Value must be 
more than 0.0 

K-Factor  
Out of Range 

K-Factor  
Out of Range 

Press  Enter 
To Stop 

Enter Menu 
    > 

Enter Menu 
         Setup     > 

Enter Menu 
    Calibration    > 

Enter Code 
0000 

    Cal Method 
      Rate       Volume 

    Cal Method 
      Rate       Volume 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

      Enter Menu
       Calibration         >

Using the information from the VOLUME method, the 2551 will recalculate a new K-Factor. 
Press ENTER to accept the new value, or use the keypad to adjust the value.

This message appears if the new K-Factor is less than 0.0001 or greater than 999999.
To correct the problem, perform the volumetric flow again, and be certain that the 
volume entered is accurate.

3s 

ENTER 

Or 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

1234.56  GPM
       876543.21    >

Enter Menu
   >

Enter Menu
Setup    >

Enter Menu
Calibration    >

Enter Menu
Relay 1    >

Enter Menu
Relay 2    >

Enter Menu
Relay 3    >

Enter Menu
Test    >

Enter Menu
Options    >

Using the information from the RATE MATCHING method, the 2551 will recalculate a new K-Factor.  
Press ENTER to accept the new value, or use the keypad to adjust the value.

The flow rate shown is based on the existing calibration of the 2551. Use the keypad to modify 
the flow rate to match the reference meter. The 2551 will automatically calculate a new K-Factor 
based on the new flow rate.

This message appears if the new K-Factor is less than 0.0001 or greater than 999999.
To correct the problem, reexamine the flow rate and make certain it is accurate.

Set New Flowrate 
45.6789 

Press  Enter 
To Start 

Enter Volume 
000000.   GPM 

K-Factor 
45.6789 

K-Factor 
56.7890 

Value must be 
more than 0.0 

K-Factor  
Out of Range 

K-Factor  
Out of Range 

Press  Enter 
To Stop 

Enter Menu 
    > 

Enter Menu 
         Setup     > 

Enter Menu 
    Calibration    > 

Enter Code 
0000 

    Cal Method 
      Rate       Volume 

    Cal Method 
      Rate       Volume 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

      Enter Menu
       Calibration         >

Set New Flowrate 
45.6789 

Press  Enter 
To Start 

Enter Volume 
000000.   GPM 

K-Factor 
45.6789 

K-Factor 
56.7890 

Value must be 
more than 0.0 

K-Factor  
Out of Range 

K-Factor  
Out of Range 

Press  Enter 
To Stop 

Enter Menu 
    > 

Enter Menu 
         Setup     > 

Enter Menu 
    Calibration    > 

Enter Code 
0000 

    Cal Method 
      Rate       Volume 

    Cal Method 
      Rate       Volume 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

      Enter Menu
       Calibration         >

NOTE: The Security Code must be entered 
before selecting the calibration method.

Calibration Menu

Rate Method of Calibration

Volume Method of Calibration
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Magmeter models 3-2551-21 and -22 have two dry contact relays (Relays 1 and 2) and one Solid 
State relay (Relay 3).

Any of these relays can be set to any of the operating modes listed below.

The setpoint values for HIGH, LOW and WINDOW modes can be set to negative values if required. 
For example, a LOW alarm might be set to activate if the flow rate falls below -10 GPM.

Negative values are not available for relays in PULSE or TOTAL modes.

Off: If a relay is not used, it can be turned Off to prevent contact wear.

Program a relay to activate when the Resettable totalizer reaches a specific value. The maximum setting is 999999.

Application example: A filter must be replaced in an R.O. system every 10000 gallons. The service representative that installs 
a new filter sets relay 3 to Total mode, sets the setpoint at 10000 and resets the totalizer to 000000.00. Every time the Totalizer 
reaches 10000, the relay activates and lights a message indicator to remind the service representative to replace the filter.

When the totalizer is reset, the relay will be deactivated and the process begins anew.

Program a relay to activate for a fixed period, for each volume of fluid that passes the sensor.
For example, program the relay to pulse once for 100 ms for every 3 gallons that pass by the sensor.

Relay 1 Mode 
                   Low                > 

Relay 1 Mode 
                  High                > 

Relay 1 Mode 
               Window             > 

Relay 1 Mode 
                 Pulse               > 

Relay 1 Mode 
                  Total               > 

Relay 1 Set High 
                   000000                  > 

Relay 1 Set Low 
               00.000  GPM             > 

Relay 1 Set High 
               00.000  GPM             > 

Relay 1 Set Low 
               00.000  GPM             > 

Relay 1 Hys 
               00.000  GPM            > 

Relay 1 Delay 
                0.1 secs                  > 

Relay 1 Set High 
               00.000  GPM             > 

Relay 1 Hys 
               00.000  GPM            > 

Relay 1 Delay 
                0.1 secs                  > 

Relay 1 Hys 
               00.000  GPM            > 

Relay 1 Delay 
                0.1 secs                  > 

Relay 1 Width 
                0.1 secs                  > 

Relay 1 Volume 
               0.0000   Gal            > 

Signet Magmeter 

RELAY 1 RELAY 2 

ENTER 

Enter  Menu 
                    Relay 1                > 

Relay Volume: Set the volume of fluid that the 2551 must 
measure before activating the relay for one pulse.

Pulse Width: Adjust the length of time the relay will remain 
activated. The pulse width setting is dependent on the type of 
external equipment being connected to the relay.

Relay 1 Mode 
                   Low                > 

Relay 1 Mode 
                  High                > 

Relay 1 Mode 
               Window             > 

Relay 1 Mode 
                 Pulse               > 

Relay 1 Mode 
                  Total               > 

Relay 1 Set High 
                   000000                  > 

Relay 1 Set Low 
               00.000  GPM             > 

Relay 1 Set High 
               00.000  GPM             > 

Relay 1 Set Low 
               00.000  GPM             > 

Relay 1 Hys 
               00.000  GPM            > 

Relay 1 Delay 
                0.1 secs                  > 

Relay 1 Set High 
               00.000  GPM             > 

Relay 1 Hys 
               00.000  GPM            > 

Relay 1 Delay 
                0.1 secs                  > 

Relay 1 Hys 
               00.000  GPM            > 

Relay 1 Delay 
                0.1 secs                  > 

Relay 1 Width 
                0.1 secs                  > 

Relay 1 Volume 
               0.0000   Gal            > 

Signet Magmeter 

RELAY 1 RELAY 2 

ENTER 

Enter  Menu 
                    Relay 1                > 

3s 

ENTER 

Or 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

1234.56  GPM
       876543.21    >

Enter Menu
   >

Enter Menu
Setup    >

Enter Menu
Calibration    >

Enter Menu
Relay 1    >

Enter Menu
Relay 2    >

Enter Menu
Relay 3    >

Enter Menu
Test    >

Enter Menu
Options    >

NOTE: The Security Code must be entered 
before modifying the relay menu.

Set New Flowrate 
45.6789 

Press  Enter 
To Start 

Enter Volume 
000000.   GPM 

K-Factor 
45.6789 

K-Factor 
56.7890 

Value must be 
more than 0.0 

K-Factor  
Out of Range 

K-Factor  
Out of Range 

Press  Enter 
To Stop 

Enter Menu 
    > 

Enter Menu 
         Setup     > 

Enter Menu 
    Calibration    > 

Enter Code 
0000 

    Cal Method 
      Rate       Volume 

    Cal Method 
      Rate       Volume 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

      Enter Menu
       Calibration         >

Relay Menus

Pulse Relay Mode

Total Relay Mode
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The values shown for each menu item represent the factory standard 
setting. All 2551 magmeters are packaged with these settings.

Hysteresis

Time

Low Setpoint

Process

Relay activated
Relay deactivated

Hysteresis

Time

High Setpoint

Process

High Limit
Hysteresis

Hysteresis

Window

Time

Low Limit

Process

1 

1 

2

2

3 1 2 3

3

3

1 2 3 1 2 3 1 2 3 1 2 3

Pulse Out:  1 Pulse per gallon

PULSE WIDTH adjusted

4 5 6

1 2 3 4 5 6

Total Out:1.6 gallons 1 2

K-Factor: 3 Pulses per gallon

          Reset Reset

Program the relay to activate when the flow rate reaches a setpoint (High or Low) or when the flow 
rate moves outside of a prescribed range (Window).

Reverse Flow
The setpoint values for HIGH, LOW and WINDOW modes can be set to negative values if required.
For example, a LOW alarm might be set to activate if the flow rate falls to -10 GPM.

The menu repeats for Relay 2 and Relay 3.

Set High: 
Set the flow rate where a High relay will be activated.

Set Low: 
Set the flow rate where a Low relay will be activated.

Hysteresis: 
�Set a flow rate increment where the relay will be deactivated. 
The hysteresis setting serves to prevent relay "chatter" when 
the flow rate recovers from an alarm condition by requiring the 
low rate to move substantially within the setpoint.

Delay: �
Set a time period for the relay to wait after reaching the setpoint. 
This delay serves to prevent the relay "chatter" by allowing the 
flow rate time to move back within the setpoint.

Relay 1 Mode
                   Low                >

Relay 1 Mode
                  High                >

Relay 1 Mode
               Window             >

Relay 1 Mode
                 Pulse               >

Relay 1 Mode
                  Total               >

Relay 1 Set High
                   000000                  >

Relay 1 Set Low
               00.000  GPM             >

Relay 1 Set High
               00.000  GPM             >

Relay 1 Set Low
               00.000  GPM             >

Relay 1 Hys
               00.000  GPM            >

Relay 1 Delay
                0.1 secs                  >

Relay 1 Set High
               00.000  GPM             >

Relay 1 Hys
               00.000  GPM            >

Relay 1 Delay
                0.1 secs                  >

Relay 1 Hys
               00.000  GPM            >

Relay 1 Delay
                0.1 secs                  >

Relay 1 Width
                0.1 secs                  >

Relay 1 Volume
               0.0000   Gal            >

3s 

ENTER 

Or 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

1234.56  GPM
       876543.21    >

Enter Menu
   >

Enter Menu
Setup    >

Enter Menu
Calibration    >

Enter Menu
Relay 1    >

Enter Menu
Relay 2    >

Enter Menu
Relay 3    >

Enter Menu
Test    >

Enter Menu
Options    >

Set New Flowrate 
45.6789 

Press  Enter 
To Start 

Enter Volume 
000000.   GPM 

K-Factor 
45.6789 

K-Factor 
56.7890 

Value must be 
more than 0.0 

K-Factor  
Out of Range 

K-Factor  
Out of Range 

Press  Enter 
To Stop 

Enter Menu 
    > 

Enter Menu 
         Setup     > 

Enter Menu 
    Calibration    > 

Enter Code 
0000 

    Cal Method 
      Rate       Volume 

    Cal Method 
      Rate       Volume 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

      Enter Menu
       Calibration         >

NOTE: The Security Code 
must be entered before 
modifying the relay menu.

Relay behavior with LOW Setpoint 

Relay behavior with HIGH Setpoint 

Relay behavior with WINDOW Setpoints 

High, Low, or Window Relay Modes
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The Options Menu contains those features and settings that will normally be set one time and then seldom changed. These include 
language preference, decimal placement, Security Code assignment, etc.

Language 
              English             > 

Security Code 
                  ****                  > 

Contrast 
                     2                  > 

Total Reset 
               Lock On            > 

Noise Rejection 
                60 Hz               > 

Flow Decimal 
                 ****.**              > 

Total Decimal 
               ******.**              > 

Separator 
                 ddd.d             > 

Output Mode 
           Frequency         > 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

Enter  Menu
                    Options                >

Select from English, French, German, Italian, Portuguese or 
Spanish. This selection will be displayed at first power-up of a 
new magmeter.

Security Code can be set to any four digit number. 
Factory standard setting is 0000.

Set for best view after the magmeter is installed.   
Larger number means display appears darker.

Lock ON requires the Security Code before resetting the 
Resetable Totalizer.  Lock OFF reset with no security code.

Filters out common 50 or 60 Hz electrical noise.

Set the maximum resolution for the FLOW RATE display by 
limiting the decimal to this point. The Flow Rate display will 
auto-scale from this resolution up to whole units.

Set the maximum resolution for the TOTALIZER display by 
limiting the decimal to this point. The Totalizer display will 
always show this resolution.

Select decimal point or comma for use in numeric displays.

For Frequency/Digital models only: Select Freq output,  
Freq ÷ 10 output, Mirror Relay 1 output or (S3L) Digital output.

In FREQUENCY output mode, the 2551 serves as a traditional flow sensor and provides an output pulse that is compatible 
with all Signet POWERED flow instruments. It is not compatible with the 5090 Self-Powered Flow Meter or the 8150-1 Battery-
Powered Flow Totalizer. The frequency output range is from 0 Hz to 1000 Hz.
The FREQUENCY ÷ 10 output mode reduces the output frequency of the 2551 to a range that is useful for some programmable 
logic controllers (PLC). The frequency output range is from 0 Hz to 100 Hz. This shift does not affect the stated accuracy of the 
2551 Magmeter's frequency output.
The MIRROR RELAY 1 output mode allows 2551 Frequency/Digital models to use the Open Collector Output like a relay that can 
be programmed via the Relay 1 menu. If the magmeter is equipped with relays, this mode will mirror the settings of Relay 1.  
If the magmeter is not equipped with relays, this mode can still be selected and programmed via the Relay 1 menu.
The (S3L) Digital output mode switches the 2551 to the Signet serial data output called (S3L) (Signet Serial Sensor Link).  
In this mode the 2551 can be added to the serial bus of the Signet 8900 Multi-Parameter Controller or 9900 Transmitter.

The Test menu provides a simple method to verify that the system is operating properly. Auxiliary power MUST be connected to the 
2551 to activate the relays

Test Output 
              4.20 mA             > 

Test Relay 1 
         Open      Closed      > 

Test Relay 2 
         Open      Closed      > 

Test Relay 3 
         Open      Closed      > 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

Enter  Menu
                    Test                 >

The values shown for each 
menu item represent the 
factory standard setting. 
All 2551 magmeters are 
packaged with these settings.

Shown for 4 to 20 mA models only (3-2551-XX-22, -42).
Use the keypad to enter any current output from 4.0 mA 
minimum to 22.1 mA maximum.

Shown for Relay models Only
Toggle any of these relays ON and OFF to verify that the 
system is operating properly.

V+

V–

Auxiliary Power 
9 to 24 VDC 
0.4 A Maximum 

Auxiliary power MUST be 
connected to the 2551 to 
test the relays.

Test Menus

Output Modes

Options Menus

Language 
              English             > 

Security Code 
                  ****                  > 

Contrast 
                     2                  > 

Total Reset 
               Lock On            > 

Noise Rejection 
                60 Hz               > 

Flow Decimal 
                 ****.**              > 

Total Decimal 
               ******.**              > 

Separator 
                 ddd.d             > 

Output Mode 
           Frequency         > 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

Enter  Menu
                    Options                >

Test Output 
              4.20 mA             > 

Test Relay 1 
         Open      Closed      > 

Test Relay 2 
         Open      Closed      > 

Test Relay 3 
         Open      Closed      > 

Signet Magmeter

RELAY 1 RELAY 2

ENTER

Enter  Menu
                    Test                 >
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Grounding rings on plastic pipe 
(Install between flanges) 

or 
metal straps on metal pipe 

Sensor 
Grounding ring 

(10 cm to 1.3 m) (10 cm to 1.3 m) 

 4 in. to 50 in.  4 in. to 50 in. 

Instrument 
 

4. 

2. 2. 

Do not terminate 
shield at Magmeter 

3.
1.

Precalibration conditioning: The magmeter may appear to be unstable immediately after installation. Allow the sensor to sit in a full 
pipe for 24 hours before beginning calibration and operation.
•	 Use a cable gland or a liquid tight connector to seal the cable ports from water intrusion.
•	 Use PTFE tape or a suitable sealant on cable ports.
•	 The 2551 magmeter must be carefully grounded to eliminate electrical noise that may interfere with the measurement.
•	 Grounding requirements will vary with each installation.
•	 The following recommendations should be applied in sequence until the interference is eliminated.

	 The ground terminal on the outside of the yellow housing is connected internally to the grounding ring at the tip of the sensor. 
Connect a conductor (14 AWG/1.5 mm2 wire recommended) from this terminal directly to Earth ground to prevent electrical 
noise from interfering with the magmeter signal.

If the interference persists, apply step #2:

	 Connect grounding rings, metal clamps or grounding electrodes to the pipe immediately upstream and downstream of the 
magmeter sensor location. These devices must be in contact with the fluid.

If the interference persists, apply step #3:

	 The shield from the output cable must be terminated at the remote instrument ONLY.
	 This shield must not be connected at both ends!
If the interference persists, apply step #4:

	 Connect an additional wire (minimum AWG 14/1.5 mm2) from the remote instrument ground to the magmeter ground terminal.

Environmental Recommendations:
•	 When used properly, this product presents no inherent danger to the environment.
•	 Please follow local ordinance when disposing of this or any product with electronic components.

The 2551 Magmeter requires very little maintenance. There are no user-serviceable components in the magmeter.

•	 If the fluid contains deposits and solids that may coat the electrodes, a regular cleaning regimen is recommended.
•	 Do not use abrasive materials on the metal electrodes. Clean with soft cloth and mild detergent only.
•	 Use a cotton swab and mild detergent to remove deposits on the metal electrodes.

Grounding

Maintenance
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Troubleshooting with the RED and BLUE LEDs

No Lights: The power is off or the sensor is not connected
Solid Blue: The power is on but there is no flow in the pipe.
Blinking Blue: Normal operation, blink rate is proportional to the flow rate.
Alternating Red-Blue: Empty pipe indication (electrodes are not wet.)
Blinking Red: System errors (Electrical noise interference)
Solid Red: Instrument error (defective electronic component)

Reverse flow:
•	 Frequency out cannot distinguish reverse flow from forward flow. The output will be the absolute value.
•	 Digital (S3L) output: Reverse flow results in 0 flow rate displayed on 8900, or with negative numbers on the 9900.
•	 4 to 20 mA output can be spanned into negative flow range using the 3-0252 Configuration Tool.  

(example: 4 to 20 mA = -100 to +100 GPM).

Empty Pipe Detection
•	 Frequency output will be locked to 0 Hz if electrodes are not wet.
•	 Digital (S3L) output will be locked to 0 if electrodes are not wet.
•	 4 to 20 mA will be locked to 4 mA if electrodes are not wet.
•	 Blue and Red LED indicators on the magmeter circuit will blink alternately if the electrodes are not wet.

Symptom Possible Cause Solution

Output is erratic and unstable.

Magmeter installed too close to upstream 
obstruction.

Relocate the magmeter to have straight 
uninterrupted pipe upstream of the sensor 
for at least 10 x the pipe diameter.

Magmeter located in area exposed to air 
bubbles/pockets. Eliminate air bubbles in the pipe.

Magmeter is installed in pipe backwards.
Remove the magmeter and reinstall with 
the flow direction arrow on the sensor body 
pointed DOWNSTREAM.

Electrical noise is interfering with the 
measurement.

Review the grounding of the magmeter and 
the pipe. Install adequate Earth ground to 
allow the Magmeter to operate properly.

Electrodes are coated with deposits or 
chemical oxide layers.

Carefully clean the electrodes. Refer to 
sensor manual for details.

Output is not 0 when flow is stopped.
Electrodes not adequately conditioned in 
fluid.

Allow the sensor to sit in full pipe for 
24 hours then restart.

Fluid is moving inside the pipe. Increase the Low Flow Cutoff. (page 10)

No 4 to 20 mA output. Loop power not connected correctly. Connect 24 VDC ±10% connected to loop 
terminals 1 and 3.

4 to 20 mA current output is incorrect. 4 to 20 mA is not scaled properly. Check and reset in the Setup Menu.

No Frequency output.
No (S3L) output.

2551 is wrong model. Frequency / (S3L) model:
     3-2551-21 (w/rlys) or -41 (w/o rlys).

Incorrect setting in Options Menu. Select Frequency in the Options menu.
Wiring is not correct. Check wiring, make corrections.
Frequency input to other manufacturer's 
flow instrument does not have pull-up 
resistor.

Install 10 kΩ resistor. (page 6)

No flow rate, current output is 22 mA.
The fluid is too clean for Magmeter. Unsuitable application for Magmeter.
Electronic component failure. Return 2551 to factory.

Blank display, no backlighting, no relay 
LEDs, but external equipment using 
output signal is still working.

2551 AUX power is not connected. Connect AUX power (page 7)
     (9 to 24 VDC, 0.4 A max.)

Error Message:
     "Error Not Saved" Main power is below specification. Correct the main power deficiency.

Troubleshooting

1 

2 

3 

4 

JP
2 

D7 

D6 
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Mfr. Part No. Code Description
3-2551-P0-21 159 001 267 DN15 to DN100 (½ in. to 4 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
3-2551-T0-21 159 001 436 DN15 to DN100 (½ in. to 4 in.) PVDF and Titanium. Two SPDT relays, one solid state relay
3-2551-V0-21 159 001 269 DN15 to DN100 (½ in. to 4 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
3-2551-P0-41 159 001 261 DN15 to DN100 (½ in. to 4 in.) Polypropylene and 316L SS.
3-2551-T0-41 159 001 433 DN15 to DN100 (½ in. to 4 in.) PVDF and Titanium
3-2551-V0-41 159 001 263 DN15 to DN100 (½ in. to 4 in.) PVDF and Hastelloy-C
3-2551-P1-21 159 001 268 DN125 to DN200 (5 in. to 8 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
3-2551-T1-21 159 001 437 DN125 to DN200 (5 in. to 8 in.) PVDF and Titanium. Two SPDT relays, one solid state relay
3-2551-V1-21 159 001 270 DN125 to DN200 (5 in. to 8 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
3-2551-P1-41 159 001 262 DN125 to DN200 (5 in. to 8 in.) Polypropylene and 316L SS
3-2551-T1-41 159 001 434 DN125 to DN200 (5 in. to 8 in.) PVDF and Titanium
3-2551-V1-41 159 001 264 DN125 to DN200 (5 in. to 8 in.) PVDF and Hastelloy-C
3-2551-P2-21 159 001 435 DN250 to DN900 (10 in. to 36 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
3-2551-T2-21 159 001 454 DN250 to DN900 (10 in. to 36 in.) PVDF and Titanium. Two SPDT relays, one solid state relay
3-2551-V2-21 159 001 456 DN250 to DN900 (10 in. to 36 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
3-2551-P2-41 159 001 432 DN250 to DN900 (10 in. to 36 in.) Polypropylene and 316L SS
3-2551-T2-41 159 001 460 DN250 to DN900 (10 in. to 36 in.) PVDF and Titanium
3-2551-V2-41 159 001 462 DN250 to DN900 (10 in. to 36 in.) PVDF and Hastelloy-C

Mfr. Part No. Code Description
3-2551-P0-22 159 001 273 DN15 to DN100 (½ in. to 4 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
3-2551-T0-22 159 001 439 DN15 to DN100 (½ in. to 4 in.) PVDF and Titanium. Two SPDT relays, one solid state relay
3-2551-V0-22 159 001 275 DN15 to DN100 (½ in. to 4 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
3-2551-P0-42 159 001 279 DN15 to DN100 (½ in. to 4 in.) Polypropylene and 316L SS.
3-2551-T0-42 159 001 442 DN15 to DN100 (½ in. to 4 in.) PVDF and Titanium
3-2551-V0-42 159 001 281 DN15 to DN100 (½ in. to 4 in.) PVDF and Hastelloy-C
3-2551-P1-22 159 001 274 DN125 to DN200 (5 in. to 8 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
3-2551-T1-22 159 001 440 DN125 to DN200 (5 in. to 8 in.) PVDF and Titanium. Two SPDT relays, one solid state relay
3-2551-V1-22 159 001 276 DN125 to DN200 (5 in. to 8 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
3-2551-P1-42 159 001 280 DN125 to DN200 (5 in. to 8 in.) Polypropylene and 316L SS
3-2551-T1-42 159 001 443 DN125 to DN200 (5 in. to 8 in.) PVDF and Titanium
3-2551-V1-42 159 001 282 DN125 to DN200 (5 in. to 8 in.) PVDF and Hastelloy-C
3-2551-P2-22 159 001 438 DN250 to DN900 (10 in. to 36 in.) Polypropylene and 316L SS. Two SPDT relays, one solid state relay
3-2551-T2-22 159 001 455 DN250 to DN900 (10 in. to 36 in.) PVDF and Titanium. Two SPDT relays, one solid state relay
3-2551-V2-22 159 001 457 DN250 to DN900 (10 in. to 36 in.) PVDF and Hastelloy-C. Two SPDT relays, one solid state relay
3-2551-P2-42 159 001 441 DN250 to DN900 (10 in. to 36 in.) Polypropylene and 316L SS
3-2551-T2-42 159 001 461 DN250 to DN900 (10 in. to 36 in.) PVDF and Titanium
3-2551-V2-42 159 001 463 DN250 to DN900 (10 in. to 36 in.) PVDF and Hastelloy-C

Replacement Parts and Accessories
1220-0021 198 801 000 O-ring, FKM
1224-0021 198 820 006 O-ring, EPDM
1228-0021 198 820 007 O-ring, FFKM
3-8050.390-1 159 001 702 Retaining Nut Replacement Kit, NPT, Valox®

3-8050.390-3 159 310 116 Retaining Nut Replacement Kit, NPT, PP
3-8050.390-4 159 310 117 Retaining Nut Replacement Kit, NPT, PVDF
3-8050.396 159 000 617 RC Filter kit (for relay protection)
3-8551.521 159 001 378 Clear plastic cap for display

Frequency or Digitial (S3L) output

4 to 20 mA output




